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SRI INDU COLLEGE OF ENGINEERING & TECHNOLOGY
B. TECH -INFORMATION TECHNOLOGY

INSTITUTION VISION

To be a premier Institution in Engineering & Technology and Management with competency,
values and social consciousness.

IM1  Provide high quality academic programs, training activities and research facilities.

IM2 Promote Continuous Industry-Institute Interaction for Employability, Entrepreneurship,
Leadership and Research aptitude among stakeholders.

IMs  Contribute to the Economical and technological development of the region, state and nation.

DEPARTMENT VISION

To be a recognized knowledge centre in the field of Information Technology with self -
motivated, employable engineers to society.

DEPARTMENT MISSION

The Department has following Missions:

DM: To offer high quality student centric education in Information Technology.

DM: To provide a conducive environment towards innovation and skills.

DMs To involve in activities that provide social and professional solutions.

DM4 To impart training on emerging technologies namely cloud computing and 10T with involvement

of stake holders.

PROGRAM EDUCATIONAL OBJECTIVES (PEOSs)

PEO1: Higher Studies: Graduates with an ability to apply knowledge of Basic sciences and
programming skills in their career and higher education.

PEO2: Lifelong Learning: Graduates with an ability to adopt new technologies for ever changing
IT industry needs through Self-Study, Critical thinking and Problem solving skills.

PEO3: Professional skills: Graduates will be ready to work in projects related to complex
problems involving multi-disciplinary projects with effective analytical skills.

PEO4: Engineering Citizenship: Graduates with an ability to communicate well and exhibitsocial,

technical and ethical responsibility in process or product.




PROGRAM OUTCOMES (POs) & PROGRAM SPECIFIC OUTCOMES (PSOs)

PO

Description

PO 1

Engineering Knowledge: Apply knowledge of mathematics, natural science, computing,
engineering fundamentals and an engineering specialization as specified in WK1 to WK4
respectively to develop to the solution of complex engineering problems.

PO 2

Problem Analysis: ldentify, formulate, review research literature and analyze complex
engineering problems reaching substantiated conclusions with consideration for sustainable
development. (WK1 to WK4)

PO 3

Design/Development of Solutions: Design creative solutions for complex engineering
problems and design/develop systems/components/processes to meet identified needs with
consideration for the public health and safety, whole-life cost, net zero carbon, culture,
society and environment as required. (WK5)

PO 4

Conduct Investigations of Complex Problems: Conduct investigations of complex
engineering problems using research-based knowledge including design of experiments,
modelling, analysis & interpretation of data to provide valid conclusions. (WK8).

PO 5

Engineering Tool Usage: Create, select and apply appropriate techniques, resources and
modern engineering & IT tools, including prediction and modelling recognizing their
limitations to solve complex engineering problems. (WK2 and WK6)

PO 6

The Engineer and The World: Analyze and evaluate societal and environmental aspects
while solving complex engineering problems for its impact on sustainability with reference
to economy, health, safety, legal framework, culture and environment. (WK1, WK5, and
WK?7).

PO 7

Ethics: Apply ethical principles and commit to professional ethics, human values, diversity
and inclusion; adhere to national & international laws. (WK9)

PO 8

Individual and Collaborative Team work: Function effectively as an individual, and as a
member or leader in diverse/multi-disciplinary teams.

PO 10

Project Management and Finance: Apply knowledge and understanding of engineering
management principles and economic decision-making and apply these to one’s own work,
as a member and leader in a team, and to manage projects and in multidisciplinary
environments.

PO 11

Life-Long Learning: Recognize the need for, and have the preparation and ability for i)
independent and life-long learning ii) adaptability to new and emerging technologies and iii)

critical thinking in the broadest context of technological change. (WK8)

Program Specific Outcomes

PSO 1

Software Development: To apply the knowledge of Software Engineering, Data Communication,
Web Technology and Operating Systems for building IOT and Cloud Computing applications.

PSO 2

Industrial Skills Ability: Design, develop and test software systems for world-wide network of
computers toprovide solutions to real world problems.

PSO 3

Project implementation: Analyze and recommend the appropriate IT Infrastructure required for the
implementationof a project.




GENERAL LABORATORY INSTRUCTIONS

1. Students are advised to come to the laboratory at least 5 minutes before (to the starting
time),those who come after 5 minutes will not be allowed into the lab.

2. Plan your task properly much before to the commencement, come prepared to the lab
with thesynopsis / program / experiment details.

3. Student should enter into the laboratory with:

a) Laboratory observation notes with all the details (Problem statement, Aim,
Algorithm,Procedure, Program, Expected Output, etc.,) filled in for the lab session.

b) Laboratory Record updated up to the last session experiments and other utensils
(if any)needed in the lab.

c) Proper Dress code and Identity card.

4. Sign in the laboratory login register, write the TIME-IN, and occupy the computer system
allotted to you by the faculty.

5. Execute your task in the laboratory, and record the results / output in the lab observation
notebook, and get certified by the concerned faculty.

6. All the students should be polite and cooperative with the laboratory staff, must
maintain thediscipline and decency in the laboratory.

7. Computer labs are established with sophisticated and high end branded systems, which
should be utilized properly.

8. Students / Faculty must keep their mobile phones in SWITCHED OFF mode during the
labsessions. Misuse of the equipment, misbehaviors with the staff and systems etc., will
attract severe punishment.

9. Students must take the permission of the faculty in case of any urgency to go out ; if
anybody found loitering outside the lab / class without permission during working
hours will be treated seriously and punished appropriately.

10. Students should LOG OFF/ SHUT DOWN the computer system before he/she leaves the
labafter completing the task (experiment) in all aspects. He/she must ensure the system

/ seat is kept properly.

Head of the Department Principal
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(R22) SKILL DEVELOPMENT COURSE (DATA VISUALIZATION - R PROGRAMMING/ POWER BI)

Course Objectives:
+ Effective use of Business Intelligence (BI) technology (Tableau) to apply data visualization
¢+ To discern patterns and relationships in the data.
¢+ To build Dashboard applications.
¢+ To communicate the results clearly and concisely.
+ To be able to work with different formats of data sets.

Course Outcomes: At the end of the course a student should be able to
¢+ Understand How to import data into Tableau.
¢+ Understand Tableau concepts of Dimensions and Measures.
¢+ Develop Programs and understand how to map Visual Layouts and Graphical Properties.
¢+ Create a Dashboard that links multiple visualizations.
+  Use graphical user interfaces to create Frames for providing solutions to real world
¢+ problems.

List of Experiments:
1. Understanding Data, What is data, where to find data, Foundations for building Data
Visualizations,Creating Your First visualization?

2. Getting started with Tableau Software using Data file formats, connecting your Data to
Tableau,creating basic charts(line, bar charts, Tree maps),Using the Show me panel.

3. Tableau Calculations, Overview of SUM, AVR, and Aggregate features, Creating custom
calculationsand fields.

4. Applying new data calculations to your visualizations, Formatting Visualizations,
Formatting Toolsand Menus, Formatting specific parts of the view.

5. Editing and Formatting Axes, Manipulating Data in Tableau data, Pivoting Tableau data.
6. Structuring your data, Sorting and filtering Tableau data, Pivoting Tableau data.

7. Advanced Visualization Tools: Using Filters, Using the Detail panel, using the Size
panels,customizing filters, Using and Customizing tooltips, Formatting your data with colors.

8. Creating Dashboards &amp; Storytelling, creating your first dashboard and Story, Design




for different displays, adding interactivity to your Dashboard, Distributing &amp; Publishing
your Visualization.

9. Tableau file types, publishing to Tableau Online, Sharing your visualizations, printing, and
Exporting.

10. Creating custom charts, cyclical data and circular area charts, Dual Axis charts.

REFERENCE BOOKS:
1. Microsoft Power BI cookbook, Brett Powell, 2nd edition.
2. R Programming for Data Science by Roger D. Peng (References)
3. The Art of R Programming by Norman Matloff Cengage Learning India.




EXPERIMENT - 1: Understanding Data, What is data, where to find data, Foundations for
building Data Visualizations, Creating Your First visualization?

Aim: To Understand Data, What is data, where to find data, Foundations for building Data
Visualizations, Creating Your First visualization.

Solution :

What is Data?

Data refers to raw facts, statistics, or information collected or stored in a structured or unstructured
form. Data can take various forms, such as text, numbers, images, videos, and more. It is the
foundation of all information and knowledge and is used in various fields for analysis, decision-
making, and understanding trends and patterns.

Data can be categorized into two main types:

Structured Data: This type of data is organized into a specific format, such as tables or databases, and
is easily searchable and analyzable. Examples include spreadsheets, relational databases, and CSV files.

Unstructured Data: Unstructured data lacks a specific format and can include text documents, social
media posts, images, audio recordings, and more. Analyzing unstructured data often requires advanced
techniques like natural language processing and image recognition.

Where to Find Data?

» You can find data from various sources, depending on your specific needs:

» Open Data Portals: Many governments and organizations provide free access to a wide range of
data through open data portals. Examples include Data.gov (United States) and data.gov.uk
(United Kingdom).

» Data Repositories: Academic institutions, research organizations, and data enthusiasts often
share datasets on platforms like Kaggle, GitHub, and the UCI Machine Learning Repository.

» APIs (Application Programming Interfaces): Some websites and services offer APIs that allow
you to programmatically access and retrieve data. Examples include Twitter API, Google Maps
API, and financial market APIs.

» Web Scraping: You can extract data from websites using web scraping tools and libraries like
BeautifulSoup and Scrapy. However, be mindful of the website's terms of use and legal
restrictions.

» Surveys and Surveys: You can conduct your own surveys or collect data through
questionnaires and interviews.

» IoT Devices: Internet of Things (IoT) devices generate vast amounts of data that can be used
for various purposes.

» Commercial Data Providers: Some companies specialize in selling datasets for specific
industries, such as market research, finance, and healthcare.




Foundations for Building Data Visualizations:

Creating effective data visualizations requires a strong foundation in several key areas:

>

Data Analysis: Before creating visualizations, you should thoroughly analyze your data to
understand its structure, relationships, and any patterns or trends. Exploratory data analysis
(EDA) techniques can help with this.

Statistical Knowledge: Understanding basic statistics is essential for making meaningful
interpretations of data. Concepts like mean, median, standard deviation, and correlation are
commonly used in data visualization.

Domain Knowledge: Having knowledge of the specific domain or subject matter related to
your data is crucial for creating contextually relevant visualizations. It helps you ask the
right questions and provide valuable insights.

Visualization Tools: Familiarize yourself with data visualization tools and libraries such as
matplotlib, Seaborn, ggplot2, D3.js, and Tableau. Each tool has its strengths and can be
used for different types of visualizations.

Design Principles: Study design principles, including color theory, typography, and visual
hierarchy, to create visually appealing and effective visualizations. Avoid common pitfalls
like misleading visualizations.

Interactivity: Learn how to add interactive elements to your visualizations to engage users
and allow them to explore the data. This can be achieved using tools like JavaScript,
Python libraries, or dedicated visualization software.

Creating Your First Visualization:

To create your first data visualization, follow these general steps:

Select Your Data: Choose a dataset that aligns with your goals and interests. Ensure that the
data is clean and well-structured.

Define Your Objective: Clearly define what you want to communicate or explore with your
visualization. Are you looking to show trends, comparisons, or distributions?

Choose the Right Visualization Type: Select a visualization type that suits your data and
objectives. Common types include bar charts, line charts, scatter plots, histograms, and pie
charts.

Prepare and Transform Data: Preprocess your data as needed. This may involve
aggregating, filtering, or transforming the data to fit the chosen visualization.

Create the Visualization: Use a suitable tool or library to create your visualization.
Customize it with labels, colors, and other design elements.

Interactivity (Optional): If appropriate, add interactive features to your visualization to
allow users to interact with the data.

Test and Iterate: Review your visualization for accuracy and clarity. Seek feedback from
others and make improvements as necessary.

Publish or Share: Once you are satisfied with your visualization, publish it on a platform,
embed it in a report, or share it with your intended audience.

Document and Explain: Provide context and explanations for your visualization. Clearly
communicate what the viewer should take away from it.

Maintain and Update: If the data changes or new insights emerge, update your visualization
accordingly.




EXPERIMENT - 2: Getting started with Tableau Software using Data file formats, connecting
your Data to Tableau, creating basic charts(line, bar charts, Tree maps),
Using the Show me panel.

Aim: To get started with Tableau Software using Data file formats, connecting your Data to
Tableau,creating basic charts(line, bar charts, Tree maps),Using the Show me panel.

Solution :

Getting started with Tableau software is a great way to create data visualizations quickly and
efficiently. Here are the steps to get started, including connecting your data to Tableau, creating basic
charts like line charts, bar charts, and treemaps, and using the Show Me panel:

1. Download and Install Tableau:
First, you'll need to download and install Tableau Desktop or Tableau Public (a free version). Follow
the installation instructions provided on the Tableau website for your specific operating system.

2. Prepare Your Data:

Before connecting your data to Tableau, ensure that your data is in a suitable format. Common data
file formats that Tableau supports include Excel (.xIsx), CSV (.csv), and text files (.txt). Make sure
your data is organized with headers for each column.

3. Connect Your Data to Tableau:

3.1 Launch Tableau Desktop.
3.2 Go to "File" Menu and then click on "Open".
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3.3 Choose the data source type (e.g., Excel, CSV, text file) and Select the data file(P6-SuperStoreUS-

2015.xls) and click "Open".
3.4 Drag any table(e.g. Orders) into working area.
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3.5 Click on Worksheet(Sheetl).
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4. Data Source Pane:
Once your data is connected, the Data Source Pane will appear on the left-hand side of the Tableau
interface. Here, you can see a preview of your data and perform data transformations or join multiple
data sources if necessary.
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5. Creating Basic Charts:
Now, let's create some basic charts using Tableau:
a. Line Chart:
1. From the "Data Source pane", drag and drop the date field to the Columns shelf and a numeric
field (e.g., sales, revenue) to the Rows shelf.
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2. Then Tableau will automatically create a line chart. You can customize it by adding labels, titles,
and formatting.
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b. Bar Chart:

1. Drag and drop a categorical field (e.g., product category, region) to the Columns shelf and a numeric
field to the Rows shelf.
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2. Then Tableau will create a bar chart. You can adjust the orientation and formatting as needed. To
display Labels on the bars click on Lables and select "Show mark lables"
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¢. Treemap:

1. Drag and drop a categorical field to the Columns shelf.
2. Drag and drop a numeric field to the Size shelf.

3. Tableau will create a treemap visualization. You can further customize it by adjusting colors and
labels.

6. Using the Show Me Panel:

The Show Me panel in Tableau helps you explore various chart types based on your data and the fields
you select. Here's how to use it:

» After adding fields to the Rows and Columns shelves, click on the "Show Me" panel located on
the left side of the Tableau interface.

» In the Show Me panel, you'll see a variety of chart options that Tableau recommends based on
your data. Click on a chart type to create it.

» Tableau will automatically generate the selected chart type with your data. You can further
customize it as needed.

» To go back to the regular worksheet view, click the "Clear" button in the Show Me panel.




EXPERIMENT - 3: Tableau Calculations, Overview of SUM, AVR, and Aggregate features,
Creating custom calculationsand fields

Aim: To do Tableau Calculations, Overview of SUM, AVR, and Aggregate features, Creating custom
calculationsand fields

Solution :

Tableau offers a powerful set of calculation tools that allow you to manipulate, transform, and analyze
your data in various ways. Here's an overview of some key concepts related to Tableau calculations,

including SUM, AVG (average), and aggregate functions, as well as creating custom calculations and
fields

SUM and AVG (Average) Functions

SUM Function

The SUM function in Tableau calculates the total sum of a numeric field. You can use it to find the
sum of values in a column or as part of a more complex calculation. To use SUM, simply drag and
drop a numeric field into the "SUM" shelf, or you can create a calculated field using the SUM
function.
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AVG (Average) Function

Sales

The AVG function calculates the average (mean) value of a numeric field. Like SUM, you can use it
by dragging a numeric field into the "AVG" shelf or creating a calculated field with the AVG function.
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Tableau provides a range of aggregate functions that allow you to perform calculations on groups of
data. Common aggregate functions include SUM, AVG, COUNT, MIN (minimum value), and MAX
(maximum value). These functions are particularly useful when you want to analyze data at different
levels of granularity (e.g., by category, region, or time period).

Remian

Adossire Marmes
#  Orimcount

# Product Base Marmin

=8

<] Tmblesu - Bookl

File Data Worksheet Dashboard Story

- -— =1 5 -

Data Analytics < jom—
Futers

o

Es

Show Fitter
Show Highlighter

- sorm..
Esaiena
| s
j| [t S
1 P —
P pr—

Artribute
Measure -
Crrpe——

Standard =~ Blh) - =T

=2 [

Minimurm
Maxirmurm

Count (Distines




Creating Custom Calculations

Tableau allows you to create custom calculations using calculated fields. Here's how to create a custom
calculation:

1. Create a New Calculated Field

In the Data Source Pane, right-click on your data source and select "Create Calculated Field".
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Alternatively, you can create a calculated field by right-clicking on a shelf in your worksheet and
choosing "Create Calculated Field".

2. Enter Your Calculation:

In the calculated field editor, you can use functions, operators, and field references to define your
calculation.

For example, you can create a calculated field to calculate profit margin as (SUM(|[Profit]) /
SUM([Sales])) * 100.




3. Name and Save the Calculated Field:

Give your calculated field a meaningful name.

Click the "OK" or "Apply" button to save the calculated field.
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4. Use the Calculated Field in Your Worksheet:

You can now use the calculated field like any other field in your worksheet. Drag it to the Rows or
Columns shelf, use it in filters, or create visualizations based on it.
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EXPERIMENT - 4: Applying new data calculations to your visualizations, Formatting
Visualizations, Formatting Toolsand Menus, Formatting specific parts of the view.

Aim: To apply new data calculations to your visualizations, Formatting Visualizations, Formatting
Tools and Menus, Formatting specific parts of the view.

Solution :
Applying New Data Calculations to Visualizations

1. Drag and Drop Calculated Fields:

To apply your newly created calculated fields to a visualization, simply drag and drop them onto the
appropriate shelves in your worksheet. For example, you can drag a calculated field to the Rows or
Columns shelf, use it in filters, or place it on the Marks card to control the appearance of marks.
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2. Filter with Calculated Fields:

Create filters using calculated fields to control which data points are displayed in your visualization.
You can use calculated fields to filter by specific criteria, such as a calculated date range or a custom
ranking.
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Formatting Visualizations

Tableau provides a wide range of formatting options to make your visualizations more appealing and

informative:

1. Format Pane:

On the left side of the Tableau interface, you'll find the Format pane. It allows you to format various
aspects of your visualization, such as fonts, colors, lines, shading, and borders. Simply select the
element you want to format and use the options in the Format pane to make changes.
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2. Marks Card:

The Marks card, located above your visualization, offers formatting options specific to the type of
marks you're using (e.g., color, size, label). Click on the Marks card to access these options and modify

how your data is represented.
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3. Axis and Gridlines:

You can format axis labels, titles, and gridlines to improve the readability of your visualization. Right-

click on an axis or gridline to access formatting options.
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4. Legends and Color Scales:

Customize legends and color scales to provide context for your visualizations. You can change colors,

labels, and the position of legends to match your data.
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Formatting Tools and Menus
Tableau provides several formatting tools and menus to help you refine the appearance of your
visualizations:
1. Format Menu:
The Format menu at the top of the Tableau interface provides access to various formatting options,
including font styles, shading, borders, alignment, and more. You can use this menu to format text,
labels, and other elements.
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2. Worksheet Menu:

In the Worksheet menu, you'll find options to format the entire worksheet, including background color,

borders, and worksheet title. You can also adjust the worksheet size.
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3. Dashboard Menu:

If you're working with dashboards, the Dashboard menu allows
layout, including background, size, and title.
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Formatting Specific Parts of the View

Tableau lets you format specific elements of your visualization:

1. Annotations:

You can add annotations to your visualizations to highlight important points or provide additional
context. Format these annotations using the options available when you right-click on an annotation.
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Customize tooltips to display relevant information when users hover over data points. You can format
tooltips to show or hide specific fields and control their appearance.
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3. Headers and Titles:

Format headers, titles, and subtitles for clarity and consistency. Use the Format pane or the Format
menu to adjust text formatting, alignment, and shading.
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EXPERIMENT - 5: Editing and Formatting Axes, Manipulating Data in Tableau data, Pivoting
Tableau data.

Aim: To edit and Formatting Axes, Manipulating Data in Tableau data, Pivoting Tableau data.

Solution :

Editing and Formatting Axes:
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1. Edit Axis Title:

> Click on the axis title you want to edit.

> You can now modify the title text, font, size, color, and alignment using the Format pane or the
toolbar at the top.
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2. Edit Axis Labels:

> Right-click on an axis and select "Edit Axis."

> In the Edit Axis dialog box, you can change the formatting of labels, tick marks, and other axis-
related properties.

3. Scale and Range:

> To change the scale or range of an axis, right-click on it and select "Edit Axis."

> In the dialog box, adjust the Minimum and Maximum values, scale, or range according to your
needs.

< Tableau - Book1
File Data Worksheet Dashboard Story Analysis Map Format Server Window Help
- €« S>> -] B 6§ - - | M-dP Mg - B R IF Z - - % Standard  ~ 8- o7 L3 o
Data Analytics < Pages ili Columns
E& Orders (P6-SuperStorel

i= Rows

— _
AGG(Profit_Mar

Region
Country Central I 1 26
Customer ID Wiarks East | -3 .

c Customer Name South -a o4 N

Ll

L=

#

o ml Automatic -
aAbe Customer Segment

(=]

5l

AB

&

o |v¥ | m -~
Tables

City ~

Order Date 22 &

Order ID Color Size Labet
e Order Priority ¥ =

Postal Code Detail | Tooltip

abc Product Category Right Click
aAbe  Product Container Select Marks

Clear Axis Range

ave  Product Name F o
‘ormat...

Product Sub-Category =
Show Header

Abc
Abc Region
# RowlD Add Reference Line
B Ship Date
Abc  Ship Mode
@ State or Province

Abc  Measure Names
4 Discount

4 Product Base Margin
# Profit

=# Profit_Margin i

B Data Source Sheet1l [ H} | O}
4marks 4rowsbylcolumn  SUM of AGG(Profit_Margin ): 42.02 « 4 s |3 omm

2| Tableau - Book1 1
- €« > = =E 8 - Edit Axis [Profit_Margin ] =<

Format AGG(Profit_Marg... * Pages

General Tick Marks

A = & B = Fields -

Range
Axis Pane Filters

@ Automatic ] include zero
Default L Acoron|
O Uniform axis range for all rows or columns

Fort: | Tableau Boo.  ~

O Independent axis ranges for each row or column

Snading: [T o] e i

Scale ml Automal

Color s
Numbers: [1.23.456 ~|

Atignment: [Actomatic ~] Pttt Scate

R reed
Title O Reve
[] Logarithmic
Font: |Tableau Me.. ~
Axis Titles

Titie
Custom - Profit_Margin

Automatic

[ S S Reset

B Data Source Sheet1 | G} B O}
4 marks 4 rows by 1 column SUM of AGG(Profit_Margin ): 42.02 « 4 > > i = m




Edit Axis [Profit_Margin ] ><

General Tick Marks

Major Tick Marks /

< > Autormatic

I (= Fimed I

> None
Tick origimn Tick imterwval
=3 10

PMMinor Tick Marks

(= Auatormatic
> Fixed
D Nome

= Reset

i) Tablesu - Book1 - B X

File Data Waorksh Dashboard Story Analysis Map Format Server Window Help

A € o2 R-T- M-dPOR- B3R IE 2
Data Analytics < | Pages ili Columns
(& Orders (P6-SuperStoreU = Rows

f£ | Standard ~ B - I g ==

= o ' el _
Tobles

@ City ~ Region

® Country Central [, 1726
S man Maris East I - <0

abc Customer Name South -2 02 I

ul Automatic - =

Abc Customer Segment West 1440

£ Order Date HH &

$# OrderID Color Size Label

Apc  Order Priority e (]

@ Postal Code Detail | Tooltip

#Abc Product Category

aAbc  Product Container

Abc Product Name

Abe Product Sub-Category
abc Region

# RowlD

& Ship Date

Abc  Ship Mode

@ State or Province

abc  Measure Names

# Discount
# Product Base Margin
# Profit
=# Profit_Margin -
B Data Source Sheet1 [ H. 0}

4marks 4rowsbylcolumn SUM of AGG(Profit_Margin ): 42.02 “« @«




Manipulating Data in Tableau data
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Change Data Type

If Tableau has inferred a wrong data type for a column, the data type can be changed by clicking on the
data type symbol in the column header
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New Column(Calculated Fields)

Calculated fields can be used if you need to create customized logic for manipulating certain data types
or data values. There are a large-range of functions available in Tableau that can used individually or
collectively for data manipulation
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Pivoting Tableau data

Data pivoting enables you to rearrange the columns and rows in a report so you can view data from

different perspectives
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EXPERIMENT - 6: Structuring your data, Sorting and filtering Tableau data,
Pivoting Tableau data.

Aim:Structuring your data, Sorting and filtering Tableau data, Pivoting Tableau data.

Filters are executed in the following order:

>

YV V VYV V

Extract filters

Data source filters

Context filters

Filters on dimensions (whether on the Filters shelf or in filter cards in the view)

Filters on measures (whether on the Filters shelf or in filter cards in the view)

Select to keep or exclude data points in your view

You can filter individual data points (marks), or a selection of data points from your view. For
example, if you have a scatter plot with outliers, you can exclude them from the view so you can better
focus on the rest of the data.

To filter marks from the view, select a single mark (data point) or click and drag in the view to select
several marks. On the tooltip that appears, you can

Select Keep Only to keep only the selected marks in the view.

Profit




Profit

W [:iwp Only X Exclude &~ @~ IH
2380 items selected - SUM(Sales): $1.635.925

Select Exclude to remove the selected marks from the vi

Select headers to filter data:

To filter entire rows or columns of data from your view, select the header in the view. On the
tooltip that appears, select to Exclude or Keep Only the selected data
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Drag dimensions, measures, and date fields to the Filters shelf:

Another way to create a filter is to drag a field directly from the Data pane to the Filters shelf.
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When you add a field to the Filters shelf, the Filter dialog box opens so you can define the filter

Filter categorical data (dimensions):

Dimensions contain discrete categorical data, so filtering this type of field generally

involves selecting the values to include or exclude.

When you drag a dimension from the Data pane to the Filters shelf in Tableau Desktop, the

following Filter dialog box appears:

> exclude.

> Condition: Use the Condition tab in the Filter dialog box to define rules to filter by.

Filter quantitative data (measures)

> Measures contain quantitative data, so filtering this type of field generally involves selecting a

range of values that you want to include.

Filter dates

> When you drag a date field from the Data pane to the Filters shelf in Tableau Desktop, the

following Filter Field dialog box appears:

-
Filter Field [Order Date]
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Cancel ]




You can select whether you want to filter on a relative date; filter between a range of dates; or
select discrete dates or individual dates to filter from the view.

> Filter relative dates
> Filter a range of dates
> filter discrete dates
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Sort Data in a Visualization

There are many ways to sort data in Tableau. When viewing a visualization, data can be sorted
using single click options from an axis, header, or field label. In the authoring environment,
additional sorting options include sorting manually in headers and legends, using the toolbar
sort icons, or sorting from the sort menu.

Quickly sort from an axis, header, or field label

There are multiple ways to sort a visualization with single click sort buttons.

In all cases, one click sorts descending, two clicks sorts ascending, and three clicks clear the
sort.

The sort updates if the underlying data changes.
Sort from an axis:

» Hover over a numerical axis to bring up the sort icon.
» Click the icon to sort.




In this example, the sort is applied to Color (sorting the rows) based on the values for Metric A. If
there are hierarchical dimensions like above, the sort is applied to the innermost dimension. In this
example, Color will sort inside Hue. Dark magenta can't sort to the top of the viz because it must
stay inside the pane for the Purple hue.

Sort from a field label
» Hover over a field label to bring up the sort icon.

The sort icon for a field label is slightly different from a header or axis.
Hue  5i— Falae
Purple Alphabetic
SUM(Metric A)
" SUM(Metric B)

[ T

» Click the A-Z icon to sort alphabetically. Or, click the menu to select a field to sort by. The
icon switches to the bar icon and you can click to sort.

Sort from the toolbar

» Select the dimension you wish to sort.
» If you don‘t select a field before sorting, the default behavior is to sort the deepest dimension.
» Choose the appropriate sort button (ascending or descending) in the toolbar.
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Understanding “incorrect” sorts

It‘s easy to think a view is sorted incorrectly when in fact the sort logic is not clear. A view with a
nested sort when a non-nested sort is expected (or vice versa) can be perceived as incorrect. Sorting
when there are multiple panes can also give results that seem unsorted.

For example, this view might seem unsorted when in fact it‘s sorted on Hue by Metric.
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Clear sorts

You can sort data from many areas of a view. Sometimes it can be useful to clear all sorts at once.
To remove the sort on a specific field, right click to open the menu and select Clear Sort.

To remove all sorts in the view, open the menu next to the clear sheet icon in the toolbar and select
Clear Sorts. Or, from the Worksheet menu, click Clear > Sorts.

Pivoting data is a process that rearranges rows into columns or vice versa. For example, if you
have a dataset with two columns (A and B) and four rows (1-4), pivoting the dataset will change
the two columns (A and B) into four columns (1-4) with two rows (A and B)

How to Pivot Data in Tableau Data Source: Convert Columns to Rows

» Open up your dataset in Tableau.

You should see your worksheet on the Data Source tab with all columns and rows

AN

» Select Columns you would like to pivot

Select the columns you want to pivot by holding down the Ctrl key and selecting each one
individually or by holding Shift

Oroers Orders Croer Craers. Craers Oraers Oroers
Crcer 1D = Order Date Ship Ship Mode Customer MName Segment Country-Region

US-2019-169390 2/7/2019 2/10/2019 Second Class Chris Selesrick Corporate United States
US-Z2019-167997 1/Z6/ 2019 1r29/2019 First Class Carol Adarms Corporate United States
US-2019-167997 1/26/2019 /29,2019 First Class Caral Adams Corparate United States
US-Z019-167927 1/20,2019 1/26/2019 Standard Class Hylona Prels Consumer United States
US-2019-167927 1/20/2019 1L/26/2019 Standard Class XKylona Prels Consumer United States
US-ZO019-167927 1/20-,2019 1/ZES20ID Standard Class Hylona Preis Consumen United States
US-ZO019-167927 1/20/2019 Lr26, 2019 Standard Class Xylona Prels Consumer United States
US-2019-167927 1/2042019 LA2ES2019 Standard Class Xylona Preis Consumer United States

US-2019-167927 1/20/2019 L/26,2019 Standard Class Xylona Preis Consumer United States




3. Pivot the Data

Click on the dropdown arrow on one of the columns and select Pivot from the dropdown menu.
This will pivot your data so that your columns become rows.
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4. Rename Pivot Columns
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Rename the Pivot Columns in order to make sense and remove any duplicate columns.

5. Add to the pivot
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Orders
Count
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Pimitan

Add to the pivot by clicking on the dropdown arrow on one of the columns and select Add Data
to Pivot.
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EXPERIMENT - 7 : Advanced Visualization Tools: Using Filters, Using the Detail
panel, using the Size panels, customizing filters, Using and Customizing tooltips,
Formatting your data with colors.

Aim: To develop advanced Visualization Tools: Using Filters, Using the Detail panel, using the
Size panels, customizing filters, Using and Customizing tooltips, Formatting your data with
colors.

Open Tableau: Open Tableau Desktop and connect to your data source.

Suppose you have a dataset with fields: Product Name, Sales etc

Sample Data
PRODUCT SEPT OCT NOV DEC

NAME SALES(2022) | SALES SALES SALES SALES

CPU 100 50 15 23 15

HARDDISK 20 20 24 15 16

MONITOR 300 30 54 45 56

PENDRIVE 500 10 17 18 19

KEYBOARD 450 20 20 30 10

MOUSE 800 15 5 15 25

1.Create a Visualization: Build a visualization using the data fields available in your data
source. Drag and drop dimensions and measures onto rows and columns to create a basic view.

A) Filtering Data

Add Filters:

o Drag fields from the Data pane to the Filters shelf to apply filters. This can include
dimensions or measures related to your data.

You can:

1. Drag Product Name and Sales to the view for your main visualization.




2. Drag Product Name to the Filters shelf to filter specific products.

HGE - ST

B) Using the Detail panel

The Detail panel in Tableau provides additional control over the level of detail in your
visualizations. The Detail panel allows you to adjust the granularity of the data displayed in the
view

1. Open Tableau: Open Tableau Desktop and connect to your data source.

2. Create a Visualization: Build a visualization using the data fields available in your data
source. Drag and drop dimensions and measures onto rows and columns to create a basic view.

Data A

Self2022)

3. Access the Detail Panel: To access the Detail panel, go to the top menu and select "Analysis."
From the drop-down menu, choose "Create Calculated Field." This will open the Calculation
editor.




4. Adjust the Level of Detail: In the Calculation editor, you can create a calculated field that
adjusts the level of detail for your visualization.
For example, you might want to aggregate data at a higher or lower level than the current view.
Apply the Calculated Field: Once you've created the calculated field, drag it onto the Detail
shelf in the view. This will adjust the level of detail in your visualization based on the
calculated field.
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In Tableau, the Size shelf is used to control the size of marks in your visualization. This can be
particularly useful when you want to emphasize certain data points or represent a quantitative variable
through the size of the marks. The Size shelf can be applied to various mark types, such as circles,
squares, and other shapes

C) Using the Size panels

» Access the Size Shelf: Once you have a basic visualization, locate the Size shelf on the
left side of the Tableau interface. It's usually located above the Columns shelf.

» Assign a Field to the Size Shelf: Drag a numerical or quantitative field (measure) from
your data pane onto the Size shelf. This field will determine the size in your

visualization. For example, you might use a field like "Sales" or "Profit" to control the
size

Data e T [T il Gotumn L Frodict Name
Sheeatl (product&sales) = Rows AGG(AVERAGE)

Product Name

AVERAGE




1. Adjust Size Range: After assigning a field to the Size shelf, you can adjust the size range to
control the minimum and maximum size of the marks. To do this, right-click on the field on the

Size shelf and select "Edit Sizes." Here, you can set the range, or you can choose automatic
sizing.

2. Modify Mark Type: Depending on your visualization, you might want to change the mark
type to better represent your data. For example, you can change from circles to squares or other

shapes. To do this, click on the "Marks" dropdown on the Marks card and select a different
mark type.
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3. Add Color and Detail: You can enhance your visualization further by adding color to the
marks, adjusting transparency, or adding more detail using the Detail shelf. Drag dimensions
onto the Color or Detail shelves to add additional information to your visualization.

Customizing filters

Customizing filters in Tableau allows you to control how data is displayed in your
visualizations and dashboards.

Create a Filter:

» Drag a field from your data pane onto the Filters shelf.
» Alternatively, right-click on a field in the view and choose "Filter."




D) Using and Customizing tooltips

Tooltips in Tableau provide additional information about data points when users hover over
them in a visualization

ks

Color formatting, allowing you to customize the appearance of your charts and graphs

E) Formatting your data with colors

Color Formatting in Tableau:

> Color Legends:
In Tableau, color is often applied through legends. Drag a dimension or measure to the
"Color" shelf to assign colors to data points in the view. A color legend will appear to
the right of the visuali

Cara
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» Adjusting Colors:
Click on the color legend to open the color editor. Here, you can adjust the color palette,
choose a diverging or sequential scheme, or even create a custom color palette.

» Custom Color Palettes:
To create a custom color palette, click on the color legend, then choose "Edit Colors."
In the color editor, select "Palette" and then "Edit Colors" to customize the colors used
in the visualization
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EXPERIMENT-8: Creating Dashboards & Storytelling, creating your first dashboard and Story,
Design for differentdisplays, adding interactivity to your Dashboard, Distributing & Publishing
your Visualization

Aim: To create Dashboards & Storytelling, creating your first dashboard and Story, Design for
differentdisplays, adding interactivity to your Dashboard, Distributing & Publishing your Visualization.

Before you start creating the dashboard with Tableau, it is a good practice to design it by hand with
pen and paper. That means you must story down first. You should have a clear picture of what you
want to show on the dashboard before you open up and start designing the visualization.

In this dashboard, I am going to show four things:

The Sales numbers by Category.
Sales numbers over time.
Performance of Sales by States
Sales by City

b=

So, these are the four visualizations that I want on my superstore sales dashboard. Let‘s start creating
the dashboard with Tableau.

Sheet 1: Sales by Category

The first visualization is sales by category. For this, I will select Category and Sales from the data
pane and drop them in Row and Column shelf respectively.

Category

Langitude (generated)

Remember to rename all the sheets, as they come in very handy while designing a dashboard.




Sheet 2: Sales Overtime
The second sheet is for Sales over time. That means how the sales number performed over the years or

months. For this, select Sales and drag to the Rows and drop Order Date into the columns.

To move this visualization to a more granular level. Click on the + on year in the columns shelf. On
clicking first, the Quarter will appear and on another click on the Quarter, Month will appear. Now
drop the Year and Quarter. It will create a Month view of sales.

€« 08 ® oy 3 b Etre Vo~ - T Srowie

Data

But what I want is Month wise sales comparison over the years. That means how was the performance
in January 2016 in comparison to January 2017. To do this, pick Order Date from the data pane and
drop it on the colors card.

[

Sheet 3: Sales Across States

Now let‘s create our third sheet. In this chart, we will represent the sales distribution across the states.
That means it‘s going to be a geospatial analysis.

Select Sales and State by pressing ctrl+ click and click on show me. Out of the recommended
visualizations select the map. Click on the 49 unknown messages. Go to —Edit Locationsl then go to
country/Region, select —from fieldl. The United States will appear itself and click ok. and we have
Sales by State.




Sheet 4: Sales by City

Finally, let‘s create our fourth visualization. Here, we will show Sales by City distribution. similar to
the last chart, select Sales and City and click on the show me. Then click on the recommended
visualization. Again we have 530 unknowns, click on that then edit locations. Go to the country and
click on them from the field. You will see the United States poped out, click OK.

Here, we have city sales numbers. For a better idea of cities, select State from the data pane and drop it
on the details card.
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Now our all sheets are ready, let‘s create the Dashboard.
Create a Dashboard

To create a new dashboard click on the icon given on the bottom bar for showing the text | New
Dashboardl. When your dashboard appears, you can see all the worksheets you have created on a side
panel.

In a dashboard, you have an option to change the view of the dashboard. It can be a default or a phone
view. I don‘t like the current half view of my dashboard, to change this, click on the size drop-down
and select automatically. It may seem a small thing but trust, it can break your entire dashboard
experience.




Now just drag and drop all the sheets from the sidebar to the dashboard. Here, you have your first
dashboard.
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Sales Over Time

Still, there are some small things that you can work with, As I don‘t like the space we left on the right
due to the legends. We can utilize that space creatively. Tableau allows us to either completely remove
these legends or move them somewhere else by making them floating.

To remove the sales legend as it‘s not contributing anything to the dashboard, click on the cross icon
and it will be gone. For others, click on the legend and then to the arrow and select floating as shown
below. Now you can drag and drop it anywhere you want on the dashboard.

Category Sales Sales Over Time o eton
& 2027

Similarly, you can move the Year of order date to the respective visualization. So we have our
superstore sales number ready for the leadership to infer and plan accordingly. Here is the final
dashboard.




Create a Story

Let‘s see the various steps required to create a Story in Tableau. This story uses the Superstore data set
that is available as a sample on Tableau Desktop.

Step 1: Click on the new Story tab to create a new story. You can then add various sheets and
dashboards to create a story point.

Story 2

weary + e

Step 2: You can double-click on the sheets and dashboards on the left to add them to a story point.
You can also drag the sheets into your story point on the Tableau desktop. All the sheets and
dashboards that are added to a story are connected to their original forms. So any changes made to the
original sheets or dashboards are reflected in the story. For example, let‘s add a dashboard containing
the relation between Discounted Sales and Profit by Category to the story.
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" Story 2

Step 3: We can also add a caption to summarize the story point by clicking on —Add a captionl and
then writing it. Let‘s add the caption —Relation between Discounted Sales and Profit by Category and
Subcategoryl to our example.

° Story2




Step 4: It is possible to add another story point by 2 methods. You can either click on the Blank tab to
use a blank sheet for the next story point or click on the Duplicate tab to obtain a duplicate sheet as the
current story point. Let‘s click on the blank option.
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king on the Size option in the lower-left corner.
You can choose from one of the predefined sizes or set your custom size in pixels. You can also
change the name of your story by right-clicking on your Story tab and choosing rename.
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Now, let‘s see a complete story on the relationship between the discounted sales and profit
— (s B = S P A1 & = 3
- ° Relationship between discounted salas and profit

This presentation aims ta find if there is a relationship between discounted sales and profit.
and how much the company is prafiting or losing based on discounted sales
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Add interactivity

» Select Profit Map in the dashboard, and click the Use as filter icon in the upper right
corner.
» Select a state within the Southern region of the map.
o The Sales in the South bar chart automatically updates to show just the sub-category
sales in the selected state. You can quickly see which sub-categories are profitable.
» Click an area of the map other than the colored Southern states to clear your selection.
o You also want viewers to be able to see the change in profits based on the order date.
» Select the Year of Order Date filter, click its drop-down arrow, and select Apply to
Worksheets > Selected Worksheets.
» In the Apply Filter to Worksheets dialog box, select All in dashboard, and then click OK.
o This option tells Tableau to apply the filter to all worksheets in the dashboard that use

this same data source.
Explore state performance by year with your new, interactive dashboard!

Check your work! Watch "Add interactivity" in action

Here, we filter Sales in the South to only items sold in North Carolina, and then explore year
by year profit.

Click the image to replay it

Rename and go

You show your boss your dashboard, and she loves it. She's named it "Regional Sales and
Profit," and you do the same by double-clicking the Dashboard 1 tab and typing Regional
Sales and Profit.




In her investigations, your boss also finds that the decision to introduce machines in the
North Carolina market in 2021 was a bad idea.

Your boss is glad she has this dashboard to explore, but she also wants you to present a clear
action plan to the larger team. She asks you to create a presentation with your findings.

Before you publish your workbook, make sure you know the following:

» The name of the server and how you sign in to it. If your organization uses Tableau
Cloud, you can click the Quick Connect link.

» Any publishing guidelines your Tableau administrator might have, such as the name
of the project you should publish to.

Publish your workbook

» With the workbook open in Tableau Desktop, click the Share button in the toolbar.

%

If you aren‘t already signed in to Tableau Server or Tableau Cloud, do so now. If you don‘t have a site
yet, you can create one on Tableau Cloud.

» In the Publish Workbook dialog box, select the project to publish to.
» Name the workbook according to whether you‘re creating a new one or publishing over an

existing one.
» Under Data Sources, select Edit. For Authentication, select Allow refresh access or Embed

password.

For some data connections, only one authentication option appears. If None shows, leave it set
to that.

Data Sources
Manage Data Sources

Data Source Pubiist Type (i) Authentication

75 [

Ve Embedded in workb... - Allow refresh access -

» Click Publish.

If this is your first time publishing a workbook, test it on the server and work out any
glitches before letting other users know the workbook is available.




EXPERIMENT-9: Tableau file types, publishing to Tableau Online, Sharing your
Visualizations,printing,and Exporting.

Aim:To create Tableau file types, publishing to Tableau Online, Sharing your visualizations,
printing,and Exporting.

Tableau File Types and Folders

You can save your work using several different Tableau specific file types: workbooks,
bookmarks, packaged data files, data extracts, and data connection files. Each of these file types are
described below. For related details,

Workbooks (.twb) — Tableau workbook files have the .twb file extension. Workbooks hold one or
more worksheets, plus zero or more dashboards and stories.

Bookmarks (.tbm) — Tableau bookmark files have the .tbm file extension. Bookmarks contain a
single worksheet and are an easy way to quickly share your work. For more information.

Packaged Workbooks (.twbx) — Tableau packaged workbooks have the .twbx file extension. A
packaged workbook is a single zip file that contains a workbook along with any supporting local
file data and background images. This format is the best way to package your work for sharing with
others who don‘t have access to the original data. For more information.

Extract (.hyper) — Tableau extract files have the .hyper extension. Extract files are a local copy of
a subset or entire data set that you can use to share data with others, when you need to work offline,
and improve performance. For more information.

Data Source (.tds) — Tableau data source files have the .tds file extension. Data source files are
shortcuts for quickly connecting to the original data that you use often. Data source files do not
contain the actual data but rather the information necessary to connect to the actual data as well as
any modifications you've made on top of the actual data such as changing default properties,
creating calculated fields, adding groups, and so on. For more information.

Packaged Data Source (.tdsx) — Tableau packaged data source files have the .tdsx file extension.
A packaged data source is a zip file that contains the data source file (.tds) described above as well
as any local file data such as extract files (.hyper), text files, Excel files, Access files, and local cube
files. Use this format to create a single file that you can then share with others who may not have
access to the original data stored locally on your computer.

Simple Steps to Publish a Workbook

When you want to share a workbook with your colleagues, you can publish it to Tableau Server or
Tableau Cloud with a few simple clicks. There, other people can view it, interact with it, and even
edit it if their server permissions allow.




Before you publish your workbook, make sure you know the following:

» The name of the server and how you sign in to it. If your organization uses Tableau Cloud,
you can click the Quick Connect link.

» Any publishing guidelines your Tableau administrator might have, such as the name of the
project you should publish to.

» Publish your workbook

With the workbook open in Tableau Desktop, click the Share button in the toolbar. <o
» If you aren‘t already signed in to Tableau Server or Tableau Cloud, do so now. If you don‘t
have a site yet, you can create one on Tableau Cloud.
» In the Publish Workbook dialog box, select the project to publish to.
» Name the workbook according to whether you‘re creating a new one or publishing over an
existing one.
Under Data Sources, select Edit. For Authentication, select Allow refresh access or Embed
password.
For some data connections, only one authentication option appears. If None shows, leave it
set to that.

Crata Sources

Manage Data Sources

Embedded in workb... - Allow refresh access -

Click Publish.

If this is your first time publishing a workbook, test it on the server and work out any
glitches before letting other users know the workbook is available.Share directly with other
users.

When you share content directly with other users on your site, they receive a notification
with a link to that content. The content is also added to their Shared with Me page, so they
can easily find it later. Notifications can come by email, in Tableau‘s in-app notifications
center, or in the Tableau for Slack app if the site is connected to a Slack workspace. For
more information, see Manage Your Account Settings and Receive Notifications, Search,
and Share Using the Tableau App for Slack.

» Open the Actions (...) menu for the content you want to share.
» Select Share from the menu.

Firnmrase
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» Under Share with people, enter at least one user name. When you type, names
that match your text appear.
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» Under Message, enter an optional note to your recipients.
» Click the Share button.

Grant access to shared content
To access the content you share with them, users must have permission to view that content on

Tableau Server or Tableau Cloud.

If you control permissions for the content, you can grant access when you share it. If any of the
users you shared with don't have the ability to view the content, the option to grant access will
appear automatically after you share. You can only grant the capabilities for the view template
via the grant access dialog. To grant users other permission capabilities, follow the instructions

on Set permissions.
If you don't have the ability to set permissions for the content, the users you share with will be

able to request access upon opening the link to the shared content. Their request for access is sent
to the user who controls permissions for the content.

Copy a link to share
» Copy the link generated for a piece of content to share without sending an email to specific

users.
» Open the Actions (...) menu for the content you want to share.

» Select Share from the menu.
Click the Copy Link button, then paste the link into an application to share it with others.
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Print Views from Tableau Desktop

Before printing, specify how you want the printed page to look using the Page Setup dialog
box. Then print to a printer or PDF.



https://help.tableau.com/current/server/en-us/permissions.htm#set-permissions

Set up the page

You can apply different page setup options for each worksheet in a workbook, For example,
worksheets can print with titles showing or hidden, with unique page orientation, and more.
To begin, select File > Page Setup.

General settings (available for individual sheets, not dashboards)

» Show - Show or hide the title, view, caption, color legend, shape legend, size legend,
and map legend.
Headers and Breaks - Control the appearance of these table elements.
Repeat headers and legends on each page - adds table row and column headers at the
top of each printed page when a view breaks across several pages.
Break pages on pane boundaries - prevents page breaks in the middle of a table cell.
Pages Shelf - If the view uses the Pages Shelf, specify whether to print the current page
or all pages.

YV VYV

Layout settings

» Legend Layout - If you include one or more legends, select how you want the legends
to appear on the printed page.
» Margins - Specify top, bottom, left, and right margins by typing values into the text
boxes.
Centering - Optionally, select whether to center the view horizontally or vertically—or both—
on the page.
Print Scaling settings

These settings affect only printed documents, not exported images or PDFs. However, the page
orientation settings are used as the default when you publish the workbook to Tableau Cloud or
Tableau Server.

Print Scaling - Scale a view to fit within a single page or print across multiple pages. Select
from the following options:

Automatic — Scales the view automatically based on the paper size.

Scale to — Scales the view to the specified percentage of its original size.

Fit to — Scales the view to fit within the specified area. Select the number of printed
pages across and down. For example, if you have a really wide view that is not very tall,
you can specify three pages across by one page down.

Page Orientation - Specify how you want the view oriented on the printed page. Select
from the following options:

Use Printer Setting — Use the page orientation that is already specified by the printer.
Portrait — Presents the view so that it is oriented vertically on the printed page.
Landscape — Presents the view so that it is oriented horizontally on the printed page.

The following diagram shows the difference between portrait and landscape page

orientations.
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Print a view

After you have configured the Page Setup settings, select File > Print. The following options
in the Print dialog box are unique to Tableau.

Show Selections

When this option is selected any selections you‘ve made in the views will be maintained while
printing.

Change the Print Range

When you print from a workbook with multiple worksheets, each worksheet represents one or
more printed pages, depending on the page setup.

Select from the following print ranges:
» Entire Workbook - Prints all the worksheets in the workbook.
» Active Sheet - Prints only the sheet currently displayed in the workbook.
» Selected Sheets - Prints the selected sheets.
You can select multiple worksheets in a workbook by holding down the CTRL or Shift keys (or
the z key on a Mac) while clicking the worksheet tabs that you want to select.
Print to PDF

In Tableau Desktop, you can save views as PDF files rather than printing them as hard copies.
You do not need to have Adobe Acrobat installed on your computer.

When you print an individual sheet to PDF, filters in the view are not included. To show filters,
create a dashboard containing the sheet and export the dashboard to PDF.

Print to PDF using a Windows computer
» Specify page setup options for each sheet in your workbook.
» Select File > Print to PDF.

~
Print toc PDF |

Range FPaper Size

@ Entire Workbook [Letter - |

@) Active Sheet &) Portrait
Selected Sheats 0 Landscape
COptions

[] wriews PDF File After Printing [+ | Show Selections

| oK | | Cancel ]

In the Print to PDF dialog box, select the print Range:

Entire Workbook - Publishes all the sheets in the workbook.

Active Sheet - Publishes only the sheet currently displayed in the workbook.

Selected Sheets - Publishes the selected sheets. To select multiple sheets in a Tableau
workbook, hold down the Ctrl key as you select sheet tabs along the bottom of the
Tableau workbook.

» Select a Paper Size. If you select Unspecified, the paper size will expand to the
necessary size to fit the entire view on a single page.

YV VYV V
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» Select View PDF File After Printing if you want to automatically open the PDF after
creating it. This option is only available if you have Adobe Acrobat Reader or Adobe
Acrobat installed on your computer.

» Select whether to Show Selections. When this option is selected the selections in the
views are maintained in the PDF.

» Click OK and specify where you want to save the PDF. Then click Save.

Export your data to .csv file
» Because the .csv format is one of the most simple structured formats for data, it's supported
by a wide range of tools, databases, and programming languages. Exporting your data in the
Tableau data source using this format creates an independent data set and can be a
convenient and flexible way to share your data with others.
» There are two primary ways you can export your data in the data source to a .csv file in
Tableau: from the Data Source page and from the view.

» From the Data Source page: On the Data Source page, select Data > Export Data to
CSYV to export all the data in your data source to .csv file.

» From the view: On the sheet tab, drag a field to the Columns or Rows shelf, click the
View Data icon in the Data pane, and click the Export All button.
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Export the data source

After you connect to your data, you can export and save your data source as a Tableau data
source (.tds) file. Saving the data source creates a shortcut to your remote data and allows you
to avoid having to create a new connection to a specific data set each time. For more
information, see Save Data Sources.
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Export data used in the view
After you create a view, you can also export just the data used to generate that view.

The fields that are exported come from the fields on the shelves of the sheet. However, fields
that function as external filters, in other words, the fields that appear only on the Filters shelf,
are not included in the export. If you want to include other fields with the exported data without
changing the baseline view, you can place those fields on the Detail shelf.

The various methods for exporting the data used to generate the view is listed below.

» Export data in the view to Microsoft Access or .csv
» Export crosstab of data in the view to Excel

» Copy data in the view to clipboard

» Copy crosstab of data in the view to clipboard

Export data in the view to Microsoft Access or .csv

Export the data that is used to generate the view as an Access database (Windows only) or .csv
file (Mac only).

In Tableau Desktop, select Worksheet > Export > Data.
Select a location and type a name for your Access database or .csv file.
Click Save.

If you're on Windows, the Export Data to Access dialog box displays to give you the option to
immediately use the new Access database and continue working in Access without interrupting
your work flow.
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Destination

File name: CUsers™userab™Documents™ MMy Tableau Repc

Table name: HWCH
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Export crosstab of data in the view to Excel
\
You can export directly to Excel the data used to generate the view formatted as a crosstab.

When you export your view as a crosstab, Tableau automatically opens the Excel application
and pastes a crosstab version of the current view into a new Excel workbook.
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» In Tableau Desktop: select Worksheet > Export > Crosstab to Excel.
If you're using a Mac, this option opens a dialog box where you can save the file. You
must then manually open the file in Excel.
» In Tableau Server or Tableau Cloud, open a view or dashboard and
select Download > Crosstab.
Select which sheets from the workbook to export data from.

Copy data in the view to clipboard
Copy the data used to generate the view so that you can paste it into another application.

Create a view.

Pages fil Columns

= Rows

Dretail Tooltip
=

Select Worksheet > Copy > Data.
Open another application, such as Word, and paste the data into the document.
In this example, the fields placed on the Columns, Rows, and Color shelves are copied into the

document. However, the Customer Segment field is not copied because it is an external filter
because it appears only on the Filters shelf.
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Copy crosstab of data in the view to clipboard

You can copy a crosstab version of a view so that you can paste or transfer the data into
another application. The pasted data always appears as a crosstab, even if the initial view of the
data in Tableau did not use a crosstab format.




Copying a crosstab is restricted by some general conditions:
You must copy all records in the view. You cannot copy a subset of records.

» This option is valid for aggregated views only. It cannot be used on disaggregated
views of data because a crosstab is by definition an aggregated view of data. This
means the Aggregate Measures option on the Analysis menu must be selected in order
for copying a crosstab to work properly.

» You cannot copy a crosstab if the view contains continuous dimensions such as
continuous dates and times.

» Other restrictions may apply depending on the data in your view.

After the general conditions are met, copy the crosstab.

» Create a view.
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» Select Worksheet > Copy > Crosstab.

» Open another application, such as Excel, and paste the crosstab.
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1 | Category Category Category

2 Customer Name Furniture Office Sug Technology

3 Aaron Bergman 5391 5274 52272

4 Adam Shillingsburg 52,077 51,058 5120

5 Adrian Barton 51,280 511,489 51,704

6 Aimee Bixby 516 5379 5572

7 |Alan Barnes 5131 5769 5213




EXPERIMENT - 10:Create an Area Chart(Circular area charts)

Aim:To Create an Area Chart(Circular area charts)

An area chart is a line chart where the area between the line and the axis are shaded with a color. These
charts are typically used to represent accumulated totals over time and are the conventional way to
display stacked lines. Follow the steps below to create an area chart.

The basic building blocks for an area chart are as follows:

Mark type: Area
Columns shelf: Dimension
Rows shelf: Measure
Color: Dimension

To create an area chart, follow the steps below:

» Open Tableau Desktop and connect to the Sample - Superstore data source.
» Navigate to a new worksheet.

» From the Data pane, drag Order Date to the Columns shelf.

» On the Columns shelf, right-click YEAR(Order Date) and select Month.
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» From the Data pane, drag Quantity to the Rows shelf.
» From the Date pane, drag Ship Mode to Color on the Marks card.
» On the Marks card, click the Mark Type drop-down and select Area.
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The visualization updates to the following:
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You can add formatting to an area chart. For example, you can edit the color legend and turn on mark
labels and borders.

Build a Bullet Graph

A bullet graph is a variation of a bar graph developed to replace dashboard gauges and meters. A bullet graph
is useful for comparing the performance of a primary measure to one or more other measures. Below is a single
bullet graph showing how actual sales compared to estimated sales.

Follow the steps below to learn how to create a bullet graph.

Open Tableau Desktop and connect to the World Indicators data source.

Navigate to a new worksheet.

Hold down Shift onyourkeyboard and then,onthe Data pane,under Development
select Tourism Inbound and Tourism Outbound.

In the upper-right corner of the application, click Show Me.

In Show Me, select the Bullet Graph image.

YV V. V V V V V

Click Show Me again to close it.




1.From the Data pane, drag Region to the Rows shelf.

The graph updates to look like the following:
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Check your work! Watch steps 3 - 7 below:
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Swap reference line fields

Sometimes you might want to swap the reference lines fields. For example, the actual sales is shown
as a reference distribution instead of a bar.

To swap the two measures, right-click (control-click on the Mac) the axis and select Swap Reference

Line Fields.

Swap reference | fields




Edit the distribution

Right-click (control-click on the Mac) the axis in the view and select Edit Reference Line, and then
select one of the reference lines to modify.
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You may need to adjust the view to make it look just right. If the bars are too narrow, the numbers
are truncated; to fix this, press Ctrl + Right on the keyboard to make the bars wider. Or if you want
to center the totals over the bars—by default, they are left-aligned. Do the following:

» Right-click any of the totals on the bar chart and select Format.

» In the Format window,in the Reference Line Label area,open the Alignment control and select the
Center option for Horizontal alignment:
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Build with Density Marks (Heatmap)Use density chart to visualize patterns or trends in dense data with
many overlapping marks. Tableau does this by grouping overlaying marks, and color-coding them based
on the number of marks in the group.

Density maps help you identify locations with greater or fewer numbers of data points.

In Tableau, you can create a chart using the density mark by placing at least one continuous measure onthe
Columns shelf, and at least one dimension or measure on the Rows shelf (or vice versa), and then adding
a field to the Marks card.

The basic building blocks for a density chart are as follows:

Mark type: Density

Rows and At least one continuous measure, and at least one measure or
Columns: dimension

Marks card: At least one continuous measure

Density charts use the Density mark type. By default, Tableau will use the automatic mark type.

To show how density charts can help make sense of overlapping marks in Tableau, we_re going to start
with a scatter plot with a large number of marks and re-create it as a density chart.

To use a density chart to see orders by date, follow these steps:

» Open the World Indicators data source from the Saved Data Sources section of the Start screen.

Sample - EU Superstore

Sample - Superstore

World Indicators

» From the Health folder, drag Infant Mortality to the Columns shelf. Tableau aggregates the measure
as a sum and creates a horizontal axis.

» Drag the Life Expectancy Female to the Rows shelf.

Now you have a one-mark scatter plot.




Both Infant Mortality and Life Expectancy are listed as a Sum, rather than average. Right click on
both of these measures and to change Measure(Sum) to Average.
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» Drag the Country dimension to Details on the Marks card.

Now there are many more marks in your view. The number of marks in your view is now
equal to the number of distinct countries in this data set. If you hover over a mark, you
can see the country name, female life expectancy, and infant mortality rate.

We've created a basic scatter plot, but there are lots of overlapping marks in the view and
it's hard to see where the marks are most dense.

» On the Marks card, select Density from the menu to change this scatter plot into a density
chart.
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Tableau created a density chart by overlaying marks, called kernels, and color- coding
where those kernels overlap. The more overlapping data points, the more intense the
color is.

Tableau selected a blue color palette by default, but you can choose from ten density
color palettes or any of the existing color palettes.

» Select Color from the Marks card and select Density Multi-color Light from the menu.
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The names of the color palettes indicate whether they're designed for use on charts with
dark or light backgrounds. Since our chart has a light background, we picked a "Light"
palette.

This changes the color palette on your chart. More concentrated areas will appear red,
while areas without overlapping marks will appear green.

» In the Color menu, use the Intensity slider to increase or decrease the vividness of the
density marks. For example, increasing intensity, or vividness, lowers the "max heat"
spots in your data, so that more appear.
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» Select Size from the Marks card to adjust the size of the density's kernel.

» Build a Scatter Plot
Use scatter plots to visualize relationships between numerical variables.

In Tableau, you create a scatter plot by placing at least one measure on the Columns shelf and at least
one measure on the Rows shelf. If these shelves contain both dimensions and measures, Tableau
places the measures as the innermost fields, which means that measures are always to the right of any

dimensions that you have also placed on these shelves. The word "innermost" in this case refers to the
table structure.

Creates Simple Scatter Plot Creates Matrix of Scatter Plots
i Coumns i dor SUMSis)
= Rows SUM(Profit) = Rows 8 Category SUM(Profit)




A scatter plot can use several mark types. By default, Tableau uses the shape mark type.
Depending on your data, you might want to use another mark type, such as a circle or a
square. For more information, see Change the Type of Mark in the View.
To use scatter plots and trend lines to compare sales to profit, follow these steps:

» Open the Sample - Superstore data source.

» Drag the Profit measure to Columns.

» Tableau aggregates the measure as a sum and creates a horizontal axis.

» Drag the Sales measure to Rows.

Tableau aggregates the measure as a sum and creates a vertical axis.

Measures can consist of continuous numerical data. When you plot one number against another, you
are comparing two numbers; the resulting chart is analogous to a Cartesian chart, with x and y coordinates

Now you have a one-mark scatter plot:

» Drag the Category dimension to Color on the Marks card.

This separates the data into three marks—one for each dimension member—and encodes
the marks using color.
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https://help.tableau.com/current/pro/desktop/en-us/viewparts_marks_marktypes.htm

» Drag the Region dimension to Detail on the Marks card.
Now there are many more marks in the view. The number of marks is equal to the
number of distinct regions in the data source multiplied by the number of
departments. (If you're curious, use the Undo button on the toolbar to see what
would have happened if you'd dropped the Region dimension on Shape instead of
Detail.)

» To add trend lines, from the Analytics pane, drag the Trend Line model to the
view, and then drop it on the model type.
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» A trend line can provide a statistical definition of the relationship between two
numerical values. To add trend lines to a view, both axes must contain a field that
can be interpreted as a number—by definition, that is always the case with a
scatter plot.

» Tableau adds three linear trend lines—one for each color that you are using to
distinguish the three categories.

» Build a Text Table
In Tableau, you typically create text tables (also called cross-tabs or pivot tables)
by placing one dimension on the Rows shelf and another dimension on the
Columns shelf. You then complete the view by dragging one or more
measures to Text on the Marks card.

A text table uses the text mark type. Tableau uses this mark type automatically if
the view is constructed using only dimensions (assuming the mark type is set to

Automatic). For more information about the text mark type, see Text mark.

To create a text table that shows sales totals by year and category, follow these
steps:

» Connect to the Sample - Superstore data source.

» Drag the Order Date dimension to Columns.



https://help.tableau.com/current/pro/desktop/en-us/viewparts_marks_marktypes.htm#TextMark

Tableau aggregates the date by year and creates column headers.
Drag the Sub-Category dimension to Rows.
Tableau creates row headers. Columns with headers plus rows with headers means that a
valid table structure now exists. For more information about changing the layout for row
and column headers, see Define Table Structure.

Now you can add a measure to the view to see actual data.

Drag the Sales measure to Text on the Marks card.

Tableau aggregates the measure as a sum.
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Tableau uses text as the mark type. Each cell in the table displays the sum of sales for a
particular year and sub-category.

We can see that the chairs and phones sub-categories had the highest sales in every year.

Drag the Region dimension to Rows and drop it to the left of Sub-Category. A small triangle
will appear to indicate that the new field will be inserted to the left of the existing field.
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The view now breaks out sales by region, in addition to year and sub-category.
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Regions are listed alphabetically. You can drag Region to the right of Sub-
Category to organize the view first by sub-category, and then by region.

5 YEAR(Order Date)
i Sub-Category

You can use a table calculation to show percentages of total instead of raw dollar
values. First, you must determine how to frame the calculation.

In this case, there are three dimensions in the view: Order Date, Sub-Category,
and Region.

You could show percentages of total for a single dimension, but that can be
unwieldy. For example, if you show percentages just by region, the percentages
would be calculated across the two remaining dimensions: Sub-Category (there
are 17 sub-categories) and Year(Order Date) (there are 4 years). So you would be
dividing the total 17 x 4 = 68 ways. That would make for some tiny percentages.

Instead, show percentages using two  dimensions: Year(Order Date)
and Region. Then the percentages are calculated on the remaining dimension,
Sub-Category, that is, you calculate percent of total within each highlighted area
shown below.
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The dimensions that you use to frame your calculation are called the addressing fields, and
the fields in which you run your calculation are the partition fields.

For more information about these concepts, see The basics: addressing and partitioning.

To create a table calculation to show percentages, right-click (control-click on Mac)
the SUM(Sales) field on the Marks card, and then select Add Table Calculation.

Build a Combination Chart (Dual axis charts)

Combination charts are views that use multiple mark types in the same visualization. For
example, you may show sum of profit as bars with a line across the bars showing sum of
sales. You can also use combination charts to show multiple levels of detail in the same
view. For example, you can have a line chart with individual lines showing average sales
over time for each customer segment, then you can have another line that shows the
combined average across all customer segments.

» To create a combination chart, follow the steps below:

» Open Tableau Desktop and connect to the Sample - Superstore data
source.

» Navigate to a new worksheet.
» From the Data pane, drag Order Date to the Columns shelf.

» On the Columns shelf, right-click YEAR(Order Date) and select Month.
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» From the Data pane, drag Sales to the Rows shelf.

» From the Data pane, drag Profit to the Rows shelf and place it to the right
of SUM(Sales).
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» On the Rows shelf, right-click SUM(Profit) and select Dual-Axis.

b

it

» The view updates. Measure Names is added to Color on the Marks card to
differentiate the lines.

» Note: Some marks can be hidden behind others. To move the marks
forward or backward, right-click one of the axes in the visualization and
select Move Marks to Back or Move Marks to Front.

» On the SUM(Profit) Marks card, click the Mark Type drop-down and
select Bar.

il

In the visualization, right-click the Profit axis and select Synchronize
Axis.
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